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1 Welcome
Thank you for purchasing an HP Photosmart D7100 series printer! With this new photo
printer you can print beautiful photos, save photos to a computer, and create fun and
easy projects with or without a computer.
This guide primarily explains how to print without connecting a computer. To learn how
to print from a computer, install the printer software and view the electronic Help. For an
overview of using a computer and the printer together, see Printing from a computer. For
information about installing the software, see the Quick Start guide.
Home users can learn how to:
● Print borderless photos from the printer or from a computer
● Choose a photo layout
● Convert a color photo to black and white, or apply a color effect such as Sepia or

Antique
The printer comes with the following documentation:
● Quick Start Guide: The  Quick Start Guide explains how to set up the printer, install

the printer software, and print your first photo.
● User Guide: The User Guide is the book you are reading. This guide describes the

basic features of the printer, explains how to use the printer without connecting a
computer, and contains hardware troubleshooting information.

● Onscreen help: The onscreen HP Photosmart help describes how to use the printer
with a computer and contains software troubleshooting information.

Special features
New features and media make it easier than ever to produce high-quality photos:
● When you use the new HP Advanced Photo Paper (also called HP Photo Paper in

some countries/regions), special sensors in the printer detect a mark on the back of
the paper and automatically select the optimal print settings. For more information
about this new paper, see Choose the right paper.

● HP Real Life technologies make it easy for you to get better photos. Automatic red
eye removal and adaptive lighting to enhance detail in shadows are just a few of the
many technologies included. You can explore the many editing and enhancing
options from both the control panel and from the printer software. To access these
features from the control panel, see Improving photo quality. To learn how to find
them in the software, see HP Real Life technologies features.

Accessing the onscreen HP Photosmart help
After you have installed the HP Photosmart software on a computer, you can view the
onscreen HP Photosmart help:
● Windows PC: From the Start menu, select Programs (in Windows XP, select All

Programs) > HP > HP Photosmart D7100 series > Photosmart Help.
● Macintosh: From the Finder Help menu, choose Mac Help. From the Help Viewer

Library menu, choose HP Photosmart Mac Help.
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Printer parts

Front of printer
1 On: Press this button to turn on the printer.
2 Top cover: Lift this cover to access the ink cartridges and to clear paper jams. To lift the cover,

grasp the top cover below the HP logo and pull upward.
3 Printer Screen: Use this screen to view photos, menus, and messages.
4 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
5 Main tray: Pull out this tray and load paper, transparencies, envelopes, or other media with

the side to be printed facing down.
6 Photo tray: Lift the output tray, pull out this tray, and load small-size paper up to 10 x 15 cm

(4 x 6 inch) into the photo tray for printing with the side to be printed facing down. The paper
may be tabbed or untabbed.

7 Memory card slots: Insert memory cards here. For a list of supported memory cards, see
Insert memory cards.

8 Camera port: Connect a PictBridge™ digital camera, the optional HP Bluetooth® wireless
printer adapter, or an iPod.

Back of printer
1 Power cord connection: Use this port to connect the power cord included with the printer.
2 USB port: Use this port to connect the printer to a computer.
3 Rear access door: Remove this door to clear paper jams or to install the optional

HP Automatic Two-sided Printing Accessory. See Optional accessories.
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Main and Output trays
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the main tray.
2 Output tray: Use this tray to catch your printouts. Lift this tray to access the photo tray.
3 Output tray extender: Pull towards you to extend the output tray to catch your printouts.
4 Main tray: Pull out this tray and load plain paper, transparencies, envelopes, or other media

with the side to be printed facing down.
5 Main tray grip: Pull toward you to extend the Main tray.
6 Paper-length guide: Adjust this guide to fit close to the end of the paper in the main tray.

Photo tray
1 Paper-width guide: Adjust this guide to fit close to the edge of the paper in the photo tray.
2 Paper-length guide: Adjust this guide to fit close to the end of the paper in the photo tray.
3 Photo tray grip: Pull toward you to extend the photo tray.

HP Photosmart D7100 series User Guide 7



Control panel
1 On: Turn on the printer or put it into power save mode.
2 Back: Step back one screen at a time.
3 Home: Press to return to the home screen.
4 Navigation arrows: Adjust the crop box, navigate menu choices, and control the playback

of a video clip.
5 OK: Select a highlighted item, menu or dialog choice, and play/pause a video clip during

playback.
6 Print Preview: View a preview of the selected photo or photos.
7 Print: Print the selected photos from the inserted memory card, or from a camera connected

to the front camera port.
8 Cancel: Stops a print job.
9 Rotate: Rotate a photo or a crop box.
10 Zoom (+)(-): Zoom in or out of a photo or crop box. You can also press Zoom (-) to view

photos four at a time when viewing a photo at normal magnification.
11 Photo Fix: Automatically enhances and applies lighting, contrast, focus and red eye removal

features to all printed photos.

Indicator lights
1 On light: Solid blue if the printer is on, otherwise it is off.
2 Attention light: Flashes when there is an error condition. See the printer screen for

instructions or information about the error. For more information, see The Attention light is on.
3 Print light: Solid blue when the printer is on and ready to print, flashes blue when the printer

is printing or busy with self-maintenance.
4 Photo Fix light: Solid blue when the Photo Fix function is turned on.
5 Memory Card light: Solid blue if a memory card is inserted, flashes if the printer is accessing

a memory card, off if no memory card is inserted or if more than one card is inserted. See the
printer screen for instructions.
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Optional accessories
There are several optional accessories available for the printer that enhance its portability
for printing anywhere, anytime. The appearance of the accessories may vary from what
is shown.
To purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/go/supplies (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)

Accessory name Description

HP Automatic Two-sided Printing
Accessory

This accessory automatically flips each
page to print on both sides. You will save
money (two-sided printing reduces paper
consumption) and time (no need to
remove the paper and reinsert it to print on
the back), plus you will make bulky
documents more manageable.
This accessory may not be available in all
countries/regions.

HP Bluetooth® wireless printer adapter
1 Insert the Bluetooth adapter into the

front camera port

The HP Bluetooth® wireless printer
adapter goes into the camera port on the
front of the printer. This adapter lets you
use Bluetooth wireless technology for
printing from many Bluetooth-enabled
devices, including digital cameras,
camera phones, and PDAs.
For more information on printing with this
accessory, go to www.hp.com/go/
bluetooth.

Printer menu
Press the home button to access the home screen. You can access all of the functions
from the home screen as well as setup menus.
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View & Print
Wizard: Use the wizard to guide you through the printing process. Also use the wizard
to improve photo quality and apply advanced photo effects such as brightness and color
effects.
4×6: Use to print 4×6 inch (10 × 15 cm) photographs.
Enlargement: Use Enlargement to print different photo sizes.
Print All: Select to print all the photos from the memory card inserted in the printer.
Other Print Projects: Use Other Projects to print panoramic, HP CD/DVD Tattoos, wallet
prints, and passport photos.
– Panorama Prints: Select to turn panoramic printing On or Off (default). Select

On to print all selected photos with a 3:1 aspect ratio; load 10 x 30 cm (4 x 12 inch)
paper before printing.

– HP CD/DVD Tattoos: Select to print labels for CD/DVDs.
– Wallet Prints: Use to print wallet-sized photos.
– Passport Photos: Select to print a passport photo.

Save
Select Save to save selected images to a connected PC.

Share
Use Share to select and share photos through HP Photosmart Share.

Settings
● Tools: Use tools to display the ink gauge, adjust the print quality, print a sample

page, print a test page, and to clean and align cartridges.
– Display Ink Gauge: Use to enable an ink supply gauge on the home screen.
– Print sample page: Select to print a sample page, which is useful for checking

the print quality of the printer. This feature is not available in all printer models.
– Print test page: Select to print a test page containing information about the

printer that can help in troubleshooting problems.
– Clean Printhead: Select to clean the print head when white lines or streaks

appear in your printouts. After the cleaning finishes, the printer prints a self test
report. You have the option to clean the print head again if the report shows
print quality problems.

– Align printer: Select to align the printer when white lines or streaks appear in
your printouts.

● Bluetooth
– Device address: Some devices with Bluetooth wireless technology require you

to enter the address of the device they are trying to locate. This menu option
shows the printer address.

– Device name: You can select a name for the printer that appears on other
devices with Bluetooth wireless technology when they locate the printer.

– Passkey: When the Bluetooth Security level of the printer is set to High, you
must enter a passkey to make the printer available to other Bluetooth devices.
The default passkey is 0000.

– Visibility: Select Visible to all (default) or Not visible. When Visibility is set
to Not visible, only devices that know the printer address can print to it.
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– Security level: Select Low (default) or High. The Low setting does not require
users of other devices with Bluetooth wireless technology to enter the printer
passkey. High requires users of other devices with Bluetooth wireless
technology to enter the printer passkey.

– Reset Bluetooth options: Select to reset all items in the Bluetooth menu to
their default values.

● Help Menu: Use the help menu for instructions about using the printer.
– Cartridges: Select to see an animation of how to install an ink cartridge.
– Main Tray Loading: Select to read main tray paper loading instructions.
– Photo Tray Loading: Select to read photo tray paper loading instructions.
– Paper jams: Select to see an animation of how to clear a paper jam.
– Camera connect: Select to read instructions on how to connect a PictBridge

camera to the printer.
● Preferences

– 4 × 6 print paper size: Choose Ask before print to select the paper type and
size each time you print (default).

– Print quality: Choose either Best (default) or Normal print quality.
– Paper Type: Select Automatic (default) and the printer automatically detects

the paper type and size.
– Date Stamp: Use this option to include the date and/or time on your printed

photos.
– Colorspace: Choose a colorspace. The Auto-select default tells the printer to

use the Adobe RGB colorspace, if available. The printer defaults to sRGB if
Adobe RGB is not available.

– PictBridge Tray Select: Use to select the default paper tray for printing through
the PictBridge connection.

– Video enhancement: Select On (default) or Off. When you select On, the
quality of photos printed from video clips is improved.

– Restore Factory Defaults: Restores factory settings for all menu items except
Select language and Select country/region (under Language in
Preference menu) and Bluetooth settings (under Bluetooth in the main printer
menu). This setting does not affect HP Instant Share or Network defaults.
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2 Get ready to print
This section includes the following topics:
● Load paper
● Insert ink cartridges
● Insert memory cards

Load paper
Learn how to choose the right paper for your print job and how to load it into the input
tray for printing.

Choose the right paper
Use HP Advanced Photo Paper. It is especially designed to work with the inks in your
printer to create beautiful photos.
For a list of available HP-designed photo paper, or to purchase supplies, go to:
● www.hpshopping.com (U.S.)
● www.hp.com/eur/hpoptions (Europe)
● www.hp.com/jp/supply_inkjet (Japan)
● www.hp.com/paper (Asia/Pacific)
The printer is set by default to print the best quality photos on HP Advanced Photo Paper.
If you print on a different type of paper, be sure to change the paper type from the printer
menu. See Printer menu.

Paper loading tips
Paper loading tips:
● Load paper with the side to be printed facing down.
● You can print photos and documents on a wide variety of paper sizes, from 8 x 13 cm

(3 x 5 inch) up to 22 x 61 cm (8.5 x 24 inch). The 10 x 15 cm (4 x 6 inch) photo
paper is available with and without tabs.

● Before loading paper, pull the out main paper tray and slide out the paper-width and
paper-length guides to make room for the paper. After loading paper, adjust the
guides to fit close to the edges of the paper without bending the paper. When finished
loading paper, push the main tray back in all the way.

● Load only one type and size of paper at a time in the same tray.
● After loading paper, extend the output tray extension and raise the backstop to catch

your printed pages.

Load the main tray
Any supported photo or plain paper media
1. Extend the main tray.
2. Slide the paper-width and paper-length guides to their outermost positions.
3. Load paper with the side to be printed facing down. Make sure the stack of paper

fits loosely under the tab on the paper-length guide.
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1 Paper-width guide
2 Paper-length guide

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper.

5. Push the main tray all the way in.

1 Push in the main tray all the way

Load the photo tray
Use photo paper up to 10 x 15 cm (4 x 6 inch) with or without tabs, Hagaki cards, A6
cards, and L-size cards.
1. Lift the output tray and extend the photo tray.
2. Adjust the paper-width and paper-length guides outward to make room for the paper.

1 Output tray
2 Paper-width guide
3 Paper-length guide

3. Load up to 20 sheets of paper into the photo tray with the print side down. If you are
using tabbed paper, insert the paper so the tab is closer to you.

4. Adjust the paper-width and paper-length guides inward until they stop at the edges
of the paper. Make sure the stack of paper fits loosely under the tab on the paper-
length guide.

5. Push in the photo tray.
6. Close the output tray.
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1 Paper-width guide
2 Paper-length guide
3 Photo tray grip.

Insert ink cartridges
The first time you set up and use your HP Photosmart, make sure to install the ink
cartridges that were shipped with your printer. The ink in these ink cartridges is specially
formulated to mix with the ink in the print head assembly.

Purchasing replacement ink cartridges
When purchasing replacement cartridges, refer to the cartridge numbers that appear on
the back cover of this guide. These cartridge numbers may vary by country/region.

Note If you have already used the printer several times and you have installed
the HP Photosmart printer software, you can also find the cartridge numbers in
the printer software. Windows users: Right-click the HP Digital Imaging Monitor
icon in the Windows taskbar, and select Launch/Show HP Solution Center.
Select Settings, then Print Settings, and then Printer Toolbox. Click the
Estimated Ink Levels tab, and then click Ink Cartridge Information. To order
ink cartridges, click Shop Online. Mac users: Click HP Photosmart Studio in
the Dock. In the HP Photosmart Studio toolbar, click Devices. From the
Information and Settings pop-up menu, choose Maintain Printer and then click
Launch Utility. In the Configuration Settings list, click Supply Info.
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Ink cartridge tips
HP Vivera Inks deliver true-to-life photo quality and exceptional fade resistance resulting
in vivid colors that last for generations! HP Vivera Inks are specially-formulated and
scientifically tested for quality, purity and fade resistance.
For best print quality, HP recommends that you install all retail ink cartridges before the
install-by date stamped on the box.
For optimum printing results, HP recommends using only genuine HP ink cartridges.
Genuine HP ink cartridges are designed and tested with HP printers to help you easily
produce great results, time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer service
or repairs required as a result of printer failure or damage attributable to the use
of non-HP ink will not be covered under warranty.

Ink cartridge
1 Do not insert objects into these holes

Caution To prevent ink loss or spillage: leave the ink cartridges installed while
transporting the printer, and avoid leaving used ink cartridge(s) out of the printer
for extended lengths of time.

Ink cartridge warranty information
The HP ink cartridge(s) warranty is applicable when the product is used in its designated
HP printing device. This warranty does not cover HP ink products that have been refilled,
remanufactured, refurbished, misused, or tampered with.
During the warranty period the product is covered as long as the HP ink is not depleted
and the end of warranty date has not been reached. The end of warranty date, in YYYY/
MM/DD format, may be found on the product as indicated:

For a copy of the HP Limited Warranty Statement, see HP Warranty.
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Inserting or replacing the ink cartridges
1. Make sure the power is on, then lift the top cover. Make sure all packing material

has been removed from inside the printer.

2. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the
printer, then lift the latch.
The ink cartridge areas are color-coded for easy reference. Lift the latch below the
appropriate color to insert or replace a cartridge. From left to right, the ink cartridges
are black, yellow, light cyan, cyan, light magenta, and magenta.

1 Ink cartridge latch for the black ink cartridge
2 Ink cartridge area for the color ink cartridges

3. If you are replacing a cartridge, remove the old cartridge by pulling it toward you out
of its slot.

Recycle the old cartridge. The HP Inkjet Supplies Recycling Program is available in
many countries/regions and lets you recycle used ink cartridges free of charge. For
more information, go to www.hp.com/hpinfo/globalcitizenship/environment/recycle/
inkjet.html.

4. Remove the new ink cartridge from its packaging, and while holding it by the handle,
slide the ink cartridge into the empty slot.
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Make sure you insert the ink cartridge into the slot that has the same shaped icon
and color as the new cartridge. The copper-colored contacts should be facing the
printer as the ink cartridge is inserted.

Note The first time you set up and use the printer, make sure to install the
ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head
assembly.

5. Press down on the gray latch until it clicks into place.

6. Repeat steps 2 through 5 for each ink cartridge you are replacing.
You must install all six cartridges. The printer will not work if an ink cartridge is
missing.

7. Close the top cover.

Insert memory cards
After you have taken pictures with a digital camera, you can remove the memory card
from the camera and insert it into the printer to view and print your photos. The printer
can read the following types of memory cards: CompactFlash™, Memory Sticks,
Microdrive™, MultiMediaCard™, Secure Digital™, and xD-Picture Card™.

Caution Using any other type of memory card may damage the memory card
and the printer.

To learn about other ways of transferring photos from a digital camera to the printer, see
Connecting to other devices.

Supported file formats
The printer can recognize and print the following file formats directly from a memory card:
JPEG, uncompressed TIFF, Motion JPEG AVI, Motion-JPEG QuickTime, and MPEG-1.
If your digital camera saves photos and video clips in other file formats, save the files to
your computer and print them using a software program. For more information, see the
electronic Help.
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Inserting a memory card

Memory card slots
1 xD-Picture Card
2 Memory Stick
3 Compact Flash I and II, Microdrive
4 Secure Digital, MultiMediaCard (MMC)

Memory card types
Find your memory card in the following table and use the instructions to insert the card
into the printer.
Guidelines:
● Insert only one memory card at a time.
● Gently push the memory card into the printer until it stops. The memory card slot

allows for only a portion of the card to insert into the printer; do not try to force the
memory card all the way into the printer.

● When the memory card is inserted correctly, the memory card light flashes and then
remains solid green.

Caution 1 Inserting the memory card any other way may damage the card and
the printer.

Caution 2 Do not pull out a memory card while the memory card light is flashing
green. For more information, see Removing a memory card.

Memory card How to insert the memory card

CompactFlash ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first
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Memory card How to insert the memory card

Memory Stick ● Angled corner is on the left
● Metal contacts face down
● If you are using a Memory Stick Duo or Memory Stick PRO Duo

card, attach the adapter that came with the card before you insert
the card into the printer

Microdrive ● Front label faces up, and if the label has an arrow, the arrow points
toward the printer

● Edge with metal pinholes goes into the printer first

MultiMediaCard ● Angled corner is on the right
● Metal contacts face down

Secure Digital ● Angled corner is on the right
● Metal contacts face down

xD-Picture Card ● Curved side of card points toward you
● Metal contacts face down

Removing a memory card
Wait until the Memory Card light stops flashing, then gently pull the memory card to
remove it from the printer.

Caution Do not pull out a memory card while the Memory Card light is flashing.
A flashing light means that the printer is accessing the memory card. Removing
a memory card while it is being accessed may damage the printer and the memory
card or corrupt the information on the memory card.
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3 Printing photos without a
computer
The HP Photosmart D7100 series printer lets you select, enhance, and print photos
without even turning on the computer. Once you've set up the printer using the
instructions in the Quick Start Guide, you can insert a memory card in the printer and
print your photos using the buttons on the printer control panel.
You can also print photos directly from a digital camera. For more information, see Print
photos from a digital camera.

Printing photos
You can print photos without a computer in several different ways:
● Insert a memory card with photos on it into one of the memory card slots on the

printer
● Connect a PictBridge digital camera to the camera port on the front of the printer
● Install the optional HP Bluetooth® wireless printer adapter and print from a digital

camera with Bluetooth wireless technology

Print photos from a memory card
You can print photos from a memory card by inserting the card into the printer and using
the printer control panel to view, select, enhance, and print photos. You can also print
camera-selected photos—photos you marked for printing using a digital camera—
directly from a memory card.
Printing from a memory card is quick and easy, and does not drain the digital camera
batteries.

Print one or more photos
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select 4×6 or Enlargement to select your desired photo size, then press OK.
3. Select your desired paper size, then press OK.
4. Select a layout then press OK.
5. Using the arrow keys, scroll through the available photos.
6. Press OK to select one or more images.

– Press Zoom - to view up to 9 images on the printer screen.
– Press the up arrow to increase the number of prints for the selected image.

7. Press Print to print the selected photographs.
Check the Photo tray light to verify that the correct tray is selected — the light should be
off for the Main tray and on for the Photo tray.
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Print all photos on the memory card
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print, then press OK.
2. Select Print All.
3. Select the desired paper size and press OK.

➔ Select a layout and press OK.
4. Select Print Now and press OK.

Print camera-selected photos from a memory card
When you select photos for printing using a digital camera, the camera creates a Digital
Print Order Format (DPOF) file that identifies the selected photos. The printer can read
DPOF 1.0 and 1.1 files directly from a memory card.
1. Use the digital camera to select the photos you want to print. For more information,

see the documentation that came with the camera.
2. If you select default as the photo layout with the camera, select Layout to select a

photo layout.
If you select a photo layout other than default with the camera, photos print in the
camera-selected layout regardless of the printer setting.

3. Load the desired paper.
4. Remove the memory card from the digital camera and insert it into the printer.
5. When a message appears on the printer screen asking if you want to print the

camera-selected photos, press OK.
The photos you selected with the camera begin printing.

If the printer cannot find or read all of the camera-selected photos on the card, it prints
the photos that it can read.
After printing, the printer deletes the DPOF file and unmarks the photos.

Print using the Wizard
The print wizard provides detailed instructions about selecting, sizing, editing, and
printing photographs.

Note Use the wizard to improve photo quality and apply advance effects such
as brightness and color effects.

1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the prompts to print your desired photo or photos.

Print photos from video clips
You can view video clips on the printer screen, and select and print individual frames.
When you first insert a memory card containing a video clip, the printer uses the first
frame of the video clip to represent the clip on the printer screen.
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The printer recognizes video clips recorded in these formats:
● Motion-JPEG AVI
● Motion-JPEG QuickTime
● MPEG-1
The printer ignores video clips in any other format.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. To select your desired photo size, select 4×6 or Enlargement then press OK.
3. Select your desired paper size and press OK.
4. Scroll to select the available videos using the left and right arrows.

Note Videos display a video camera icon in the center of the image.

5. Press the up arrow to play the video.
6. To select a frame to print, press the up arrow to pause the video. The video must

be paused to select frames for printing.
7. Press OK to select the desired frame for printing.
8. Press Print to print the selected frames.

Print a photo index
A photo index shows thumbnail views and index numbers for up to 2000 photos on a
memory card. Use plain paper instead of photo paper to reduce costs.
A photo index may be several pages long.
Before you begin, make sure that the memory card is inserted in the printer and the paper
tray you want to use is loaded with the correct paper.
1. Select View & Print and press OK.
2. Select Print All and press OK.
3. Select 8.5×11 paper.
4. Select the index sheet icon (16 images per page) and press OK.

Stop printing
To stop a print job in progress, press Cancel.

Print photos from a digital camera
You can print photos by connecting a PictBridge digital camera directly to the camera
port of the printer with a USB cable. If you have a digital camera with Bluetooth wireless
technology, you can insert the optional HP Bluetooth® wireless printer adapter in the
printer and send photos to the printer wirelessly.
When you print from a digital camera, the printer uses the settings that you selected on
the camera. For more information, see the documentation that came with the camera.

Digital camera with Bluetooth wireless technology
If you have a digital camera with Bluetooth wireless technology, you can purchase the
optional HP Bluetooth® wireless printer adapter and print from a camera using a
Bluetooth wireless connection.
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Note You can also print from other devices with Bluetooth wireless technology,
such as PDAs and camera phones. For more information, see Connecting to
other devices and the documentation that came with your Bluetooth adapter.

1. Set the Bluetooth options for the printer using the Bluetooth menu on the display.
For more information, see Settings.

2. Load printer paper.
3. Insert the HP Bluetooth® wireless printer adapter into the camera port on the front

of the printer.
The light on the adapter flashes when the adapter is ready to receive data.

4. Follow the instructions in the documentation that came with the digital camera to
send photos to the printer.

Digital camera with PictBridge technology
1. Turn on the PictBridge digital camera and select the photos you want to print.
2. Load paper.
3. Make sure the camera is in PictBridge mode, then connect it to the camera port on

the front of the printer using the USB cable that came with the camera.
Once the printer recognizes the PictBridge camera, the selected photos print
automatically.

Print photos from an iPod
If you have an iPod that can store photos, you can connect your iPod to the printer and
print the photos.

Before you begin
Check that the images you copy to the iPod are in JPEG format.

Note iPods might not be available in your country/region.

To import photos to an iPod
1. Copy photos from a memory card to your iPod using the Belkin Media Reader for

iPod.
2. Verify that photos are on your iPod by selecting Photo Import on the iPod menu.

Photos appear as Rolls.

To print photos from an iPod
1. Connect the iPod to the camera port on the front of the printer using the USB cable

that came with the iPod. The printer screen displays Reading Device for several
minutes while the photos are read. Then the photos appear on the printer screen.

2. Select the photo(s) you want to print and press Print. For more information on
selecting and printing photos, see Printing photos.

Photo layouts
Select the desired print function from the View & Print menu and press OK, choose your
desired print function, then select your desired paper size to select a layout.
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Layout Paper size (photo size)

1 per page borderless 4 x 6 inch (4 x 6 inch)
10 x 15 cm (10 x 15 cm)
5 x 7 inch (5 x 7 inch)
8.5 x 11 inch (8.5 x 11 inch)

1 per page 3.5 x 5 inch (3.25 x 4.75 inch)
4 x 6 inch (3.75 x 5.75 inch)
10 x 15 cm (9.53 x 14.6 cm)
5 x 7 inch (4.75 x 6.75 inch)
8 x 10 inch (7.75 x 9.75 inch)
8.5 x 11 inch (8 x 10 inch)
A6 (9.86 x 14.16 cm)
A4 (20 x 25 cm)
Hagaki (9.36 x 14.16 cm)
L (8.25 x 12.06 cm)

2 per page 3.5 x 5 inch (2.25 x 3.25 inch)
4 x 6 inch (2.75 x 3.75 inch)
5 x 7 inch (3.25 x 4.75 inch)
8 x 10 inch (4.75 x 6.5 inch)
8.5 x 11 inch (5 x 7 inch)
A6 (6.92 x 9.86 cm)
A4 (13 x 18 cm)
Hagaki (6.8 x 9.36 cm)
L (5.87 x 8.25 cm)

3 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.625 inch)
5 x 7 inch (2.25 x 3.375 inch)
8 x 10 inch (3.33 x 5 inch)
8.5 x 11 inch (4 x 6 inch)
A6 (4.77 x 7.15 cm)
A4 (10 x 15 cm)
Hagaki (4.52 x 6.78 cm)
L (3.96 x 5.94 cm)

4 per page 3.5 x 5 inch (1.5 x 2.25 inch)
4 x 6 inch (1.75 x 2.5 inch)
5 x 7 inch (2.2 x 3.25 inch)
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Layout Paper size (photo size)
8 x 10 inch (3.5 x 4.75 inch)
8.5 x 11 inch (3.5 x 5  inch)
A6 (4.77 x 6.92 cm)
A4 (9 x 13 cm)
Hagaki (4.52 x 6.5 cm)
L (3.96 x 5.7 cm)

9 per page 3.5 x 5 inch (1 x 1.375 inch)
4 x 6 inch (1.125 x 1.5 inch)
5 x 7 inch (1.5 x 2 inch)
8 x 10 inch (2.25 x 3 inch)
8.5 x 11 inch (2.5 x 3.25 inch) – Wallet
size
A6 (3.07 x 4.05 cm)
A4 (6.4 x 8.4 cm)
Hagaki (2.9 x 3.86 cm)
L (2.53 x 3.36 cm)

Note The printer may rotate the photos to fit the layout.

Improving photo quality
The printer provides a variety of enhancements that can improve the quality of a photo
printed from a memory card. These print settings do not change the original photo. They
only affect printing.

Adjust photos with poor brightness
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press

OK to view the menu.
4. Select Edit Photo and press OK.
5. Select Photo Brightness and press OK.
6. Press  and  to increase or decrease the photo brightness to the desired level,

then press OK.

Remove red eye from photos
The automatic red eye removal feature is enabled when you turn on the Photo fix function.
Enabling the Photo Fix function applies Smart Focus, Adaptive Lighting, and red eye
removal features to selected photos.
➔ Press Photo Fix to enable the Photo Fix function.
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Adjust poor-quality video clips
This preference affects photos printed from video clips.

Improve the quality of photos printed from video clips
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Using the arrow keys, find and select Video Enhancement and press OK.
4. Select On, then press OK.
For information about printing photos from video clips, see Print photos from a memory
card.

Getting creative
The printer provides a variety of tools and effects that let you use your photos in creative
ways. These print settings do not change the original photo. They only affect printing.

Add a color effect
You can set the printer to change the color option applied to a photo from Color (default)
to Black & white, Sepia, or Antique.
Photos printed in Sepia print in brown tones and look similar to photos produced in the
early 1900s. Photos printed in Antique print in the same brown tones, but with some
pale colors added to give the appearance that the photos are hand-colored.
1. Select View & Print and press OK.
2. Select Wizard and press OK.
3. Follow the onscreen instructions to select your paper size and photo, then press OK.
4. Select Done Selecting and press OK.
5. Select Edit Photo and press OK.
6. Select Color Effect and press OK.
7. Select the desired color effect and press OK.

Add the date and time to your prints
You can print a stamp on the front of your photos that shows when the photo was taken.
This preference affects all prints.
1. Select Settings and press OK.
2. Using the arrow keys, find and select Preferences and press OK.
3. Select Date Stamp and press OK.
4. Select one of the following date/time stamp options:

– Date and Time
– Date Only
– Off

If you use a computer to modify the photo and then save your changes, the original date
and time information are lost. Changes that you make to the photo using the printer
control panel do not affect the date and time information.

Change the print quality
You can change the print quality for photos. Best quality is the default and produces the
highest quality photos. Normal quality conserves ink and prints faster.
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To change the print quality:
1. Select Settings and press OK.
2. Select Preferences and press OK.
3. Select Print quality and press OK.
4. Select the desired print quality and press OK.
Print quality will revert to Best after the next print job.

Crop a photo
Press Zoom + and Zoom – to increase or decrease the magnification by 1.25×. The
maximum level is 5.0×.
1. Select View & Print and press OK.
2. Select 4×6 or Enlargement to select your desired photo size and press OK.
3. Select the desired paper size and press OK.
4. Select the desired photo and press OK.
5. Press Zoom + to increase the magnification of the photo by 1.25×. The green crop

box appears. Press Zoom + repeatedly until you reach the desired magnification.
(After zooming in, you can zoom back out by pressing Zoom –.)

Note The crop box changes from green to yellow if printing at the selected
magnification will noticeably reduce the print quality.

6. At any magnification level, press the arrows to move the crop box left, right, up, or
down.

7. Press OK when the portion of the image you want to print is in the crop box.
Cropping does not change the original photo. It only affects printing.

Print panoramic photos
1. Select View & Print and press OK.
2. Select Other Projects and press OK.
3. Select Panorama Prints and press OK.
4. Follow the prompt to load 10 x 30 cm (4 x 12 inch) media, then pressOK.
5. Select a photo and press OK. If desired, crop the photo before printing. The crop

box has a 3:1 aspect ratio.

Note All photos printed in panoramic mode are printed borderless.
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4 Getting connected
Use the printer to stay connected to other devices and people.

Connecting to other devices
This printer offers several ways of connecting to computers or other devices. Each
connection type lets you do different things.

Connection type and what you need This lets you...

Memory cards

A memory card

A compatible digital camera memory card
Insert the memory card into the
appropriate memory card slot on the front
of the printer.

● Print directly from a memory card to
the printer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software. For more
information, see Saving photos to a
computer and Print photos from a
memory card.

USB
● A Universal Serial Bus (USB) 2.0 full-

speed compliant cable 3 meters (10
feet) or less in length. For instructions
about connecting the printer with a
USB cable, see the Quick Start
booklet.

● A computer with Internet access (to
use HP Photosmart Share).

● Print from a computer to the printer.
See Printing from a computer.

● Save photos from a memory card
inserted in the printer to a computer
where you can enhance or organize
them in the HP Photosmart Premier
or other software.

● Share photos through HP Photosmart
Share.

● Print directly from an HP Photosmart
direct-printing digital camera to the
printer. For more information, see
Print photos from a digital camera and
the camera documentation.

PictBridge Print directly from a PictBridge-compatible
digital camera to the printer.
For more information, see Print photos
from a digital camera and the camera
documentation.
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Connection type and what you need This lets you...

The PictBridge symbol

A PictBridge-compatible digital camera
and a USB cable.
Connect the camera to the camera port on
the front of the printer.

Bluetooth
The optional HP Bluetooth wireless printer
adapter.
If the printer came with this accessory or
you have purchased it separately, see the
accompanying documentation and the
onscreen Help for instructions.

Print from any device with Bluetooth
wireless technology—such as a digital
camera, a camera phone, or a PDA—to
the printer.
If you connect the optional HP Bluetooth
wireless printer adapter to the printer
through the camera port, be sure to set the
Bluetooth printer menu options as
needed. See Settings.

iPod
An iPod and the USB cable that came with
it. Connect the iPod to the camera port on
the front of the printer.

Print directly from an iPod (with photos
stored in it) to the printer. For more
information, see Print photos from an
iPod.
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Saving photos to a computer
You can save photos to a computer from any memory card inserted in the printer, if you
set up a USB connection between the two devices.

If you are using a Windows computer
Use either of these methods to save photos to your computer.
● Insert a memory card into the printer. The HP Photosmart Premier transfer software

(HP Transfer and Quick Print) opens on your computer screen and allows you to
designate a location on the computer to save images. For more information, see the
onscreen HP Photosmart software help.

● Insert a memory card into the printer. The memory card appears in Windows
Explorer as a removable drive. Open the removable drive and drag photos from the
card to any location on your computer.

If you are using a Macintosh
1. Insert a memory card into the printer.
2. Wait for iPhoto to start and read the contents of the memory card.

Note iPhoto starts only if it is set as the default application.

3. Click Import to save the photos on the card to your Macintosh.

Note The memory card also appears on the desktop as a drive icon. You can
open it and drag photos from the card to any location on your Macintosh.

Connecting through HP Photosmart Share
Use HP Photosmart Share to share photos with friends and relatives using e-mail, online
albums, or an online photo finishing service. Your printer must be connected through a
USB cable to a computer with Internet access and have all the HP software installed. If
you try to use Share and do not have all the required software installed or configured, a
message prompts you through the required steps.

Use Share (USB) to send photos (Windows users):
1. Insert a memory card and select some photos.
2. Select Share on the printer screen and press OK.
3. Follow the instructions on your computer to share the selected photos with others.

Use Share (USB) to send photos (Mac users)
1. Open HP Photosmart Studio and select photos to share. For information about

HP Photosmart Studio, see HP Photosmart Premier (Windows users).
2. In the HP Photosmart Studio toolbar, click Share.
3. Click Continue, and follow the instructions on your computer to share the selected

photos with others.
See the onscreen software help for more information about using HP Photosmart Share
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5 Printing from a computer
To print from a computer, the printer software must be installed. During software
installation, either HP Photosmart Premier (Windows Full-install users), HP Photosmart
Essential (Windows Express-install users) or the HP Photosmart Studio (Mac) is installed
on your computer, allowing you to organize, share, edit, and print photos.
For more information on installing the software, see the Quick Start Guide. Update the
software regularly to ensure you have the latest features and improvements; for
instructions, see Update the software.
To work with photos, you need to transfer them to a computer that is connected to the
printer. See Saving photos to a computer.

Note Windows users: HP Photosmart Premier can only be used on computers
with processors that have Intel® Pentium® III (or equivalent) and higher.

Using creative options in the printer software
Read through these tips on how to open and use HP Photosmart Premier,
HP Photosmart Essential, HP Photosmart Studio (Mac), and HP Photosmart Share.

HP Photosmart Premier (Windows users)
HP Photosmart Premier is an easy-to-use software program that gives you everything
you need to have fun with your photos, in addition to basic photo editing and printing.
This software also gives you access to HP Photosmart Share so that you can easily share
your photos.

Open HP Photosmart Premier
➔ Double-click the HP Photosmart Premier icon on your desktop. If you need help,

see the software help within HP Photosmart Premier.
Explore the many features of HP Photosmart Premier:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos in different sizes and in multiple layouts.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments using HP

Photosmart Share, a better way to send e-mail.
● Create — Easily create album pages, cards, calendars, panoramic photos, CD

labels, and more.
● Back-up — Make back-up copies of your photos to store and save.

HP Photosmart Essential (Windows users)
HP Photosmart Essential is an easy-to-use software program that gives you basic photo
editing and printing capabilities. This software also gives you access to HP Photosmart
Share so that you can easily share your photos. HP Photosmart Essential is only
available for Windows users.
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Open HP Photosmart Essential
➔ Double-click the HP Photosmart Essential icon on your desktop. If you need help,

see the software help within HP Photosmart Essential.
Explore the many features of HP Photosmart Essential:
● View — View photos in multiple sizes and ways. Easily organize and manage your

photos.
● Edit — Crop your photos and fix photos with red eye. Automatically adjust and

enhance your photos to make them perfect.
● Print — Print your photos in different sizes and in multiple layouts.
● Share — Send photos to family and friends without the bulky attachments with HP

Photosmart Share, a better way to send e-mail.

HP Photosmart Studio (Macintosh Users)
➔ Click the HP Photosmart Studio icon in the Dock.
Explore the many features of the HP Photosmart Mac software that is accessible from
the HP Photosmart Studio:
● Import — Import photos or videos from an HP digital camera.
● View and Manage — View, organize, and manage your photos and videos.
● Edit — Adjust and enhance your images.
● Slideshow — Create an online slideshow of your photos.
● Panorama — Create a single panoramic image from several images.
● Create — Create album pages, cards, labels, posters, banners, and more.
● Print — Print your photos and frames from video in standard sizes or in index sheet

format.
● Share — Send photos to family and friends without the bulky attachments.
● Shop — Order online prints and gifts.

HP Photosmart Share
HP Photosmart Share allows you to send photos to family and friends without bulky e-
mail attachments. For more information, see Connecting through HP Photosmart
Share and the HP Photosmart Premier or HP Photosmart Essential help.

Open HP Photosmart Share (Windows users)
➔ Click the HP Photosmart Share tab within HP Photosmart Premier or

HP Photosmart Essential.

Open HP Photosmart Share (Mac users)
➔ Click the Applications tab in HP Photosmart Premier, then double-click HP

Photosmart Share.

Set print preferences
Print preferences are set by default, but can be altered to suit your needs. You can set
specific job settings when you print from the computer. When you change settings before
printing, the changes only affect the current print job. In some Windows software
programs, you need to click Properties or Preferences within the Print dialog box to
access the advanced printing features. See the electronic Help for more information
about printing preferences.
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Access print preferences (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box tabs, or click Properties or

Preferences to access more printing preferences.

Access print preferences (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Change the printing preferences in the Print dialog box by selecting the print options

you want to change in the Copies & Pages drop-down menu.
For more information on changing the printing preferences, see the electronic Help.

Open the electronic help

Windows users:
● Press F1 on your keyboard.
● For field-level help, click the ? in the top right corner of the Print dialog box.

Mac users:
1. From the Finder, choose Help > Mac Help.
2. Choose HP Photosmart Mac Help from the Library menu, and then choose the

printer name in the HP Photosmart Mac Help table of contents.

HP Real Life technologies features
Explore the many photo editing and enhancing options in the HP Real Life technologies
software features. These features—such as automatic red eye removal and adaptive
lighting—make it easy for you to print high-quality photos.
There are three options available:
● The Basic setting sharpens images and improves the quality and clarity of low

resolution images, such as those downloaded from the Internet.
● The Full setting improves images that are under exposed or over exposed, contain

dark areas or red eye, or have colors that appear washed out.
● The Off setting lets you edit the image manually in a software program such as

HP Photosmart software.

Access Real Life technologies features (Windows users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Click the Paper/Quality tab, then click the Real Life Digital Photography button

—OR— Click the Properties or Preferences button, and then click the Real Life
Digital Photography button.

Access Real Life technologies features (Mac users)
1. Open the Print dialog box, usually by selecting Print from the File menu.
2. Select Real Life Digital Photography from the Copies & Pages drop-down menu.
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6 Care and maintenance
The printer requires very little maintenance. Follow the guidelines in this section to extend
the life span of the printer and printing supplies, and to ensure that the photos you print
are always of the highest quality.
● Clean and maintain the printer
● Update the software
● Store and transport the printer and ink cartridges
● Maintain the quality of photo paper

Clean and maintain the printer
Keep the printer and print cartridge clean and well maintained using the simple
procedures in this section.

Clean the outside of the printer
1. Turn off the printer, then disconnect the power cord from the back of the printer.
2. Wipe the outside of the printer with a soft cloth that has been lightly moistened with

water.

Caution Do not use any type of cleaning solution. Household cleaners and
detergents may damage the printer finish. Do not clean the interior of the printer.
Keep all fluids away from the interior. Do not lubricate the metal rod on which the
print head slides. Noise is normal when the print head moves back and forth.

Aligning the printer
Use the following procedure when the self test report shows streaking or white lines
through any of the blocks of color.
If you still have print quality problems after aligning the printer, try cleaning the print head
using the procedure described in Care and maintenance. If print quality problems persist
after aligning and cleaning, contact HP Support.
1. Load letter or A4 unused plain white paper into the Main tray.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Scroll to find then select Align printer.

The printer aligns the print head, prints an alignment page, and calibrates the printer.
Recycle or discard the alignment page.

5. Press OK.

Print a sample page
You can print a sample page to test the printer photo printing quality and to make sure
the paper is loaded correctly.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Print sample page and press OK.
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Automatically clean the printhead
If you notice white lines or streaks on the photos you print, or in the color blocks of the
self test report, use this procedure to clean the print head. Do not clean the print head
unnecessarily, as this wastes ink and shortens the life of the ink nozzles on the print head.
1. Load paper in the Main tray. Use plain paper to conserve photo paper.
2. Select Settings and press OK.
3. Select Tools and press OK.
4. Select Clean printhead and press OK.
If print quality still seems poor after you clean the print head, try aligning the printer using
the procedure described in Aligning the printer. If print quality problems persist after
cleaning and aligning, contact HP support.

Manually clean the ink cartridge contacts
Clean the copper-colored ink cartridge contacts if a message appears on the printer
screen that says a cartridge is missing or damaged.
Before cleaning the ink cartridge contacts, remove the ink cartridge and verify that
nothing is covering the ink cartridge contacts or the ink cartridge slot, then reinstall the
ink cartridge. If you continue to get a message that says a cartridge is missing or
damaged, clean the ink cartridge contacts. If you still get this message after cleaning the
contacts, you will need a replacement ink cartridge. Remove the affected ink cartridge
and look at the end-of-warranty date on the bottom, in YYYY/MMM/DD format. If it is
before the end-of-warranty date, contact HP support to obtain a replacement ink
cartridge.

To clean the ink cartridge contacts:
1. Gather the following items to clean the contacts:

– Distilled, filtered, or bottled water (tap water may contain contaminants that can
damage the ink cartridge)

Caution Do not use platen cleaners or alcohol to clean the ink cartridge
contacts. These can damage the ink cartridge or the HP Photosmart
printer.

– Dry foam rubber swabs, lint-free cloth, or any soft material that will not come
apart or leave fibers.

2. Open the top cover of the printer.
3. Squeeze the gray tab below an ink cartridge slot to release the gray latch inside the

printer, then lift the latch.

Caution Do not remove multiple ink cartridges at the same time. Remove
and clean each ink cartridge one at a time. Do not leave the ink cartridge
outside the printer for more than 30 minutes.

4. Lightly moisten a swab or cloth with water and squeeze out any excess water.
5. Hold the ink cartridge by its handle and gently wipe only the copper-colored contacts

with the swab or cloth.
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1 Gently wipe only the copper-colored contacts
6. Place the ink cartridge back into the empty slot and press down on the gray latch

until it clicks into place.
7. Repeat if necessary for the other ink cartridges.
8. Close the top cover.

Caution The ink supply may become pressurized. Inserting a foreign object into
the ink supply could result in ink being expelled and coming in contact with
persons or property.

Print a self test report
If you are experiencing problems with printing, print a self test report. This two-page report
—labelled the Extended Self Test Diagnostic Page—can help you diagnose printing
problems and can provide valuable information if you need to call HP Support. You can
also use this report to check on the approximate percentage of ink remaining in the ink
cartridges.
1. Select Settings and press OK.
2. Select Tools and press OK, then scroll to Print test page.
3. Select Print test page and press OK.
The HP Photosmart prints a two-page self test report that contains the following
information:
● Product information: Includes the model number, serial number, and other product

information.
● Revision information: Includes the firmware version number and indicates whether

or not you have an HP two-sided printing accessory (duplexer) installed.
● Ink delivery system information: Displays the approximate ink level of each

installed ink cartridge, the status of each ink cartridge, the date each cartridge was
installed, and the expiration date for each cartridge.

● Print head assembly information: Contains information that may be used for
diagnostic purposes if you need to call HP Support.

● Print head parameters: Contains information that may be used for diagnostic
purposes if you need to call HP Support.

● Print quality pattern: Displays six color blocks, representing each of the six
installed cartridges. When streaks appear through the color blocks, or there are
missing color blocks, clean the print head using the procedure described in Care
and maintenance. If the color blocks still show print quality problems after cleaning
the print head, align the printer using the procedure described in Aligning the
printer. If the color blocks continue to show print quality problems after cleaning and
aligning, contact HP support.

● History log: Contains information that may be used for diagnostic purposes if you
need to call HP Support.
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Self test report

Update the software
Download the latest printer software update periodically to ensure you have the latest
features and improvements. You can download printer software updates by going to
www.hp.com/support or by using HP Software Update.

Note The printer software update that you download from the HP Web site does
not update the HP Photosmart Premier software.

Downloading the software (Windows)

Note Make sure you are connected to the Internet before you use HP Software
Update.

1. From the Windows Start menu, select Programs (in Windows XP, select All
Programs) > Hewlett-Packard > HP Software Update. The HP Software Update
window opens.

2. Click Check Now. HP Software Update searches the HP Web site for printer
software updates. If the computer does not have the most recent version of the
printer software installed, a software update appears in the HP Software Update
window.

Note If the computer has the most recent version of the printer software
installed, the following message appears in the HP Software Update window:
“No updates are available for your system at this time”.

3. If a software update is available, click the checkbox next to the software update to
select it.

4. Click Install.
5. Follow the onscreen instructions to complete the installation.
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Downloading the software (Mac)

Note Make sure you are connected to the Internet before you use
HP Photosmart Updater.

1. On your Mac in the Finder, choose Go > Applications.
2. Choose Hewlett-Packard > Photosmart > HP Photosmart Updater.
3. Follow the onscreen instructions to check for software updates.

If you are behind a firewall, you need to enter the proxy server information in the
updater.

Store and transport the printer and ink cartridges
Protect the printer and ink cartridges by storing them properly when you are not using
them.

Store and transport the printer
The printer is built to withstand long or short periods of inactivity. Store the printer indoors
out of direct sunlight in a place without temperature extremes.

Caution To prevent ink loss or spillage: do not transport or store the printer on
its side, and leave the ink cartridges installed while storing and transporting the
printer.

Store and transport the ink cartridges
When you transport or store the printer, always leave the active ink cartridge inside the
printer to prevent the ink from drying out.

Caution 1 To prevent ink loss or spillage: leave the ink cartridges installed while
storing and transporting the printer, and avoid leaving used ink cartridge(s) out of
the printer for extended lengths of time.

Caution 2 Make sure the printer completes its power-down cycle before you
unplug the power cord. This allows the printer to store the print head properly.

Follow this tip to help maintain your HP ink cartridges and ensure consistent print quality:
Keep all unused ink cartridges in their original sealed packages until they are needed.
Store ink cartridges at room temperature (15-35 °C or 59-95 °F).

Maintain the quality of photo paper
For best results with photo paper, follow the guidelines in this section.

To store photo paper
● Store the photo paper in its original packaging or in a resealable plastic bag.
● Store the packaged photo paper on a flat, cool, and dry surface.
● Return unused photo paper to the plastic bag. Paper left in the printer or exposed

to the elements may curl.
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To handle photo paper
● Always hold photo paper by the edges to avoid fingerprints.
● If the photo paper has curled edges, place it in its plastic storage bag and gently

bend it in the opposite direction of the curl until the paper lies flat.
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7 Troubleshooting
The HP Photosmart printer is designed to be reliable and easy to use. This chapter
answers frequently asked questions about using the printer and printing without a
computer. It contains information about the following topics:
● Printer hardware problems
● Printing problems
● Error messages
For additional troubleshooting information, see:
● Software installation troubleshooting: The Quick Start guide that came with the

printer.
● Printer software and printing from a computer troubleshooting: The onscreen

HP Photosmart Printer Help. For information about viewing the onscreen
HP Photosmart Printer Help, see Welcome.

Printer hardware problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Note If you want to connect the printer to a computer with a USB cable, HP
recommends using a 2.0 high-speed compliant cable 3 meters (10 feet) or less
in length.

The Print light is flashing blue but the printer is not printing
Solution The printer is busy processing information; wait for it to finish.

The Attention light is on

Solution
● Check the printer screen for instructions. If a digital camera is connected to the

printer, check the camera screen for instructions. If the printer is connected to
a computer, check the computer monitor for instructions.

● Turn off the printer, then unplug its power cord. Wait about 10 seconds, then
plug it in again. Turn on the printer.

If the Attention light stays on after trying the above solutions, go to www.hp.com/
support, or contact HP Support for help.
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The printer does not find the photos I stored on my memory card
Solution The memory card may contain file types the printer cannot read directly
from the card.
● Save the photos to a computer, then print them from the computer. For more

information, see the onscreen HP Photosmart help and the documentation that
came with the camera.

● The next time you take photos, set the digital camera to save them in a file
format the printer can read directly from the memory card. For a list of supported
file formats, see Printer specifications. For instructions on setting the digital
camera to save photos in specific file formats, see the documentation that came
with the camera.

The memory card may need to be reformatted if the problem persists.

The printer is plugged in but will not turn on

Solution
● The printer may have drawn too much power. Unplug the printer power cord.

Wait about 10 seconds, then plug the cord back in. Turn on the printer.
● The printer may be plugged into a power strip that is turned off. Turn on the

power strip, then turn on the printer.
● The power cord could be defective. Make sure the green light on the power cord

is lit.

The printer makes noises when I turn it on, or starts making noises after sitting
unused for a while

Solution The printer may make noises after long periods of inactivity
(approximately 2 weeks) or when its power supply has been interrupted and then
restored. This is normal operation. The printer is performing an automatic
maintenance procedure to ensure it produces the best quality output.

All the lights are flashing on the printer
Solution The printer has encountered a hardware error and may need to be
serviced. Unplug the power cord to the printer. Wait about 10 seconds, and then
plug it in again. Turn on the printer. If the lights are still flashing, please go to
www.hp.com/support, or contact HP Support for help.

Printing problems
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
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The printer does not print borderless photos when I print from the control panel
Solution Make sure the correct layout is selected when setting up the print job.
When selecting photo and paper size, the image rectangle must be solidly filled with
orange to indicate a borderless print.

Printing is very slow
Solution You may have one of the following situations: 1) you may be printing a
PDF or a project containing high-resolution graphics or photos or 2) you may have
selected the highest resolution for your printout. Large, complex projects containing
graphics or photos print slower than text documents, especially at higher resolutions.

Paper does not feed into the printer correctly from the Main tray

Solution
● There may be too much paper loaded in the tray. Remove some paper and try

printing again.
● The Main tray may not be pushed in all the way. Push the Main tray all the way in.
● The paper guides may not be adjusted correctly. Make sure the paper-width

and paper-length guides fit close to the edges of the paper without bending the
paper.

● Two or more pieces of paper may be sticking together. Remove the paper from
the Main tray, fan the edges of the stack to separate the sheets of paper, then
reload the paper and try printing again.

● If the paper is wrinkled or bent, try using different paper.
● The paper may be too thin or too thick. Use HP inkjet paper for best results. For

more information, see Choose the right paper.

Printed pages are dropping off of the Output tray
Solution Always extend the Output tray extension when you print.

The printout is rippled or curled
Solution The project you are printing uses a larger amount of ink than normal.
Print the project from a computer, and use the printer software to lower the ink
saturation level. See the onscreen HP Photosmart help for more information.

The document printed at an angle or is off-center

Solution
● The paper may not be loaded correctly. Reload the paper, making sure it is

correctly oriented in the Main tray and that the paper-width and paper-length
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guides fit close to the edges of the paper. For paper-loading instructions, see
Paper loading tips.

● If you are using a two-sided printing accessory, try removing it, replacing the
rear access door, and printing again.

● The printer may need to be aligned. For more information, see Aligning the
printer.

Colors are not printing satisfactorily

Solution
● One of the color ink cartridges may be empty, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is empty, replace it. For more information, see Insert ink cartridges.

● The printer may need to be aligned. For more information, see Aligning the
printer.

● The print head may need to be cleaned. For more information, see Care and
maintenance.

No page came out of the printer or the paper jammed while printing

Solution
● The printer may need attention. Read the printer screen for instructions.
● The power may be off or there may be a loose connection. Make sure the power

is on and the power cord is securely connected.
● You may not have any paper in the Main tray or Photo tray. Check that the paper

is loaded correctly. For paper-loading instructions, see Paper loading tips.
● If the paper jammed while printing, try the following:

– Turn off the printer, then unplug it from the power source. Clear the printer
of any paper obstructing the paper path. Remove the rear access door.
Gently remove the jammed paper from the printer, then replace the rear
access door. If all jammed paper cannot be removed from the rear area of
the printer, try removing paper jammed in the middle of the printer by
opening the paper jam door located inside the top cover. For illustrations
of the two places to clear a paper jam, see Paper errors. When you are
finished clearing the paper jam, plug the printer back in, turn it on, and try
printing again.

– If you were printing labels, make sure a label did not become unglued from
the label sheet while going through the printer.

A blank page came out of the printer

Solution
● You may have begun printing and then cancelled the print job.
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If you cancelled the print job before printing started, the printer may have already
loaded paper in preparation for printing. The next time you print, the printer
ejects the blank page before starting the new printing project.

● A print job with a large amount of data may have been sent to the printer.
Wait for the printer to service the print head before it continues printing.

The printer asked me to print an alignment page
Solution Periodically, the printer needs to perform a print head alignment to
maintain optimal print quality.
When prompted, load plain letter or A4 paper. Discard or recycle the alignment page.

The photo did not print using the default print settings
Solution You may have changed the print settings for the selected photo. Print
settings you apply to an individual photo override the default print settings. Discard
all print settings that have been applied to an individual photo by deselecting the
photo. For more information, see Settings.

The printer ejects the paper when preparing to print
Solution Direct sunlight could be interfering with the operation of the automatic
paper sensor. Move the printer out of direct sunlight.

Print quality is poor

Solution
● One of the ink cartridges may be very low on ink, resulting in another color being

substituted during printing. Check the estimated ink levels by viewing the ink
level icons from the Tools menu (Settings > Tools > Display Ink Gauge). If an
ink cartridge is low on ink, replace it. For more information, see Insert ink
cartridges.

● Use photo paper designed for the printer. For best results, use the papers
recommended in Choose the right paper.

● You may be printing on the wrong side of the paper. Make sure the paper is
loaded with the side to be printed facing down.

● You may have selected a low-resolution setting on the digital camera. Reduce
the size of the image and try printing again. For better results in the future, set
the digital camera to a higher photo resolution.

● There may be a problem with an ink cartridge or with the print head. Try the
following:
– Remove and then reinsert each ink cartridge, one at a time, to make sure

they are all properly seated.
– Run the automatic print head cleaning procedure. For more information,

see Care and maintenance.
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– Align the printer. For more information, see Aligning the printer.
– If print quality problems persist after you have tried all of the above

solutions, contact HP Support.

Photos are not printing correctly

Solution
● You may have loaded the photo paper incorrectly. Load the photo paper with

the side to be printed facing down.
● The photo paper may not have fed into the printer correctly. Try the following:

– Check for a paper jam. For more information, see Paper errors.
– Insert the photo paper as far as it will go into the Photo tray.
– Load one sheet of photo paper at a time.

The photos I marked for printing in the digital camera do not print
Solution Some digital cameras let you mark photos for printing in both the
camera's internal memory and on the memory card. If you mark photos in the internal
memory, and then move photos from the camera's internal memory to the memory
card, the marks do not transfer. Mark photos for printing after you transfer them from
the digital camera's internal memory to the memory card.

Error messages
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.
Error messages that appear on the printer screen can be divided into the following types:
● Paper errors
● Ink cartridge errors
● Memory card errors
● Computer printing errors

Paper errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Paper jam. Clear jam then press OK.
Solution Turn off the printer, then unplug it from the power source. Clear the
printer of any paper that may be obstructing the paper path. Remove the rear access
door. Gently remove the jammed paper from the printer, then replace the rear access
door.
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1 Remove the rear access door to clear paper jams.

If you cannot remove all jammed paper from the rear area of the printer, try removing
paper jammed in the middle of the printer by opening the paper jam door located
inside the top cover.

1 Open the paper jam door to clear paper jams in the middle of the printer.

Plug the printer back in and turn it on.

Error message: Out of paper. Load paper then press OK.
Solution Load paper, then press OK to print again. For paper-loading instructions,
see Paper loading tips.

Error message: Unsupported media size.
Solution The printer cannot use the size of paper loaded in the paper tray. Press
OK, then load a supported paper size instead. For a list of supported paper sizes,
see Printer specifications.

Error message: Automatic paper sensor failed.
Solution The automatic paper sensor is obstructed or damaged. Try moving the
printer out of direct sunlight, then press OK and try printing again. If this does not
work, go to www.hp.com/support or contact HP Support.
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Ink cartridge errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Wrong ink cartridge(s) installed
Solution The first time you set up and use your HP Photosmart printer, make sure
to install the ink cartridges that were shipped with your printer. The ink in these ink
cartridges is specially formulated to mix with the ink in the print head assembly.
To resolve this error, replace the affected ink cartridge(s) with the ink cartridges that
were shipped with your HP Photosmart printer.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Incorrect ink cartridge
Solution The indicated ink cartridge(s) cannot be used after the device has
undergone initialization. Replace the ink cartridge(s) with the appropriate ink
cartridges for your HP Photosmart. The cartridge numbers you can use with this
printer appear on the back cover of this printed guide.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Replace cartridges soon
Solution The indicated ink cartridge(s) are empty.
You might be able to continue printing for a short period of time with ink remaining
in the print head assembly. Replace the indicated ink cartridge(s) or press OK to
continue.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge(s) are empty
Solution The indicated ink cartridge(s) are empty and there is not enough ink in
the printhead reservoir for normal printing and servicing tasks. Replace the indicated
ink cartridge(s) with new ink cartridge(s).
● If the black ink cartridge is empty, you can continue printing with the other color

ink cartridges by selecting that option in the displayed printer screen prompts.
● If a color ink cartridge is empty, you can continue printing with the black ink

cartridge by selecting that option in the displayed printer screen prompts.
Depending on the status of your print job, you can press OK to continue. If the HP
Photosmart is in the middle of a print job, press Cancel and restart your print job.

Note Text and photo quality will differ from those printed when using all ink
cartridges. If the empty ink cartridge(s) are not replaced soon, all printing will
stop.

For more information on replacing ink cartridges, see Insert ink cartridges.
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Error message: Cannot print
Solution The indicated ink cartridge(s) are out of ink.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
The HP Photosmart cannot continue printing until the indicated ink cartridge(s) are
replaced. All printing will stop.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Ink cartridge problem
Solution The indicated ink cartridge(s) are missing or damaged.
Replace the indicated ink cartridge(s) immediately so that you can resume printing.
If there are no ink cartridges missing from the HP Photosmart, the ink cartridge
contacts might need to be cleaned.
For more information on replacing ink cartridges, see Insert ink cartridges. For more
information on cleaning the ink cartridge contacts, see Care and maintenance.
If there are no ink cartridges missing from the HP Photosmart, and you still receive
this message after cleaning the ink cartridge contacts, you will need a replacement
ink cartridge. Remove the affected ink cartridge and look at the end-of-warranty date
on the bottom, in YYYY/MMM/DD format. If it is before the end-of-warranty date,
contact HP Support to obtain a replacement ink cartridge.

Error message: Ink Expiration Nearly Expired. —OR— Ink Cartridge(s) Expired.
Solution Each ink cartridge has an expiration date. The purpose of expiration is
to protect the printing system and to ensure ink quality. When you receive an ink
expiration message, remove and replace the ink cartridge, and then close the
message. You can also continue printing without replacing the ink cartridge, by
following the instructions on your computer screen. HP recommends replacing the
expired ink cartridges. HP cannot guarantee the quality or reliability of expired ink
cartridges. Device service or repairs required as a result of using expired ink will not
be covered under warranty.
For more information on replacing ink cartridges, see Insert ink cartridges.

Error message: Non-HP ink
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit
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Error message: Original HP ink depleted
Solution Replace the indicated ink cartridge(s) or press OK to continue.
HP recommends that you use genuine HP ink cartridges. Genuine HP ink cartridges
are designed and tested with HP printers to help you easily produce great results,
time after time.

Note HP cannot guarantee the quality or reliability of non-HP ink. Printer
service or repairs required as a result of printer failure or damage attributable
to the use of non-HP ink will not be covered under warranty.

If you believe you purchased genuine HP ink cartridge(s), go to:
www.hp.com/go/anticounterfeit

Error message: Scheduled maintenance
Solution You must align the printer to ensure excellent print quality. With letter or
A4 unused plain white paper in the Main tray, press OK. The HP Photosmart aligns
the print head, calibrates the printer, and then prints a test page. Recycle or discard
the test page.

Error message: Calibration error

Solution
● If you have color or photo paper loaded in the Main tray when you align the

printer, the alignment might fail. Load unused plain white letter or A4 paper into
the Main tray, and then try the alignment again. If the alignment fails again, you
might have a defective sensor or ink cartridge; contact HP Support.

● The ink cartridge or sensor is defective. Contact HP support.

Error message: Print cartridge cradle is stuck
Solution Remove any objects that are blocking the print head assembly.

To clear the print head assembly
1. Open the top cover, then open the paper jam door.
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1 Open the paper jam door to clear the print head assembly.
2. Remove any objects that are blocking the print head assembly, including paper

and any packing materials.
3. Turn the printer off, then turn it on again.
4. Close the paper jam door and the top cover.

Error message: Ink System Failure
Solution The print head assembly or the ink delivery system has failed and the
HP Photosmart can no longer print.
Turn off the printer, then unplug its power cord. Wait about 10 seconds, then plug it
in again. If this does not clear the error message, please contact HP Support.

Memory card errors
Before contacting HP support, read this section for troubleshooting tips or go to the online
support services at www.hp.com/support.

Error message: Photo is missing. —OR— Some photos are missing.
Solution The printer cannot read the file on the memory card, or one or more files
specified for the job are missing from the memory card. Try saving the photos to the
computer using the digital camera rather than the memory card. If a photo is missing,
you may have accidentally deleted the photo from the card.
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Error message: Card access error. Job was cancelled. Press OK.—OR— File
directory structure is corrupted. —OR— Card may be damaged. Job was
cancelled. Press OK.

Solution The printer cannot read the data on the memory card and cannot
complete any current print jobs. The data may be corrupted or there may be a
physical problem with the memory card.
● Save the files to the computer and access them from there.
● If this does not work, use a new memory card or reformat the memory card

using the digital camera. Any photos on the memory card will be lost.
● If this does not work, the photo files may be damaged or unreadable. Before

you contact HP Support, try another memory card to determine if it is the printer
or the memory card that is failing.

Error message: Cannot print photos.
Solution More than 10 photos specified for a print job may be corrupted, missing,
or are an unsupported file type. For information about supported file types, see
Printer specifications.
● Save the photos to the computer using the digital camera rather than the

memory card.
● Save the files to the computer and print from the computer.
● Print a photo index and reselect photos. For more information, see Printing

photos.

Error message: Card is password protected. Cannot access card.
Solution The printer cannot read the memory card because the card is password-
protected. Follow these steps:
1. Remove the memory card from the printer.
2. Insert the memory card in the device you originally used to store the password

on the memory card.
3. Remove the password from the memory card.
4. Remove the memory card and reinsert it in the printer memory card slot.
5. Try printing again.

Error message: Card is locked. Cannot access card.
Solution Make sure the lock switch on the card is in the unlocked position.

Error message: Card is not fully inserted. Push card in a little more.
Solution The printer can detect the memory card but cannot read it. Push the
memory card gently into the memory card slot until it stops. For more information,
see Insert memory cards.
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Error message: Use only one (1) card at a time. Please remove a memory card. —
OR— Use only one (1) device at a time. Please remove/disconnect a device.

Solution The printer has two or more different types of memory cards inserted
simultaneously, or a memory card is inserted and a digital camera is connected to
the camera port at the same time. Remove memory cards or disconnect the camera
until only one card is in the printer or only a camera is connected.

Error message: Card was removed. Job was cancelled. Press OK.
Solution You removed a memory card from the printer while it was busy printing
a file from the card. Follow these steps:
1. Press OK.
2. Reinsert the memory card and print the selected photos again. The memory

card must remain inserted until the print job is complete.
To avoid damage to memory cards in the future, do not remove them from the printer
memory card slot while they are being accessed. For more information, see
Removing a memory card.

Error message: Camera selections (DPOF) file has error.
Solution The printer is unable to read a DPOF file due to corrupted data or an
error on the memory card. Use the printer control panel to reselect the photos. For
more information, see Print photos from a memory card.

Error message: Some camera-selected photos are not on card.
Solution Some camera-selected photos are missing or have been deleted. Try
the following:
● Confirm that you did not accidentally delete the photo from the memory card.
● Reselect the photos again using the digital camera.
● Print a new photo index to see the index numbers associated with each photo.

For more information, see Printing photos.

Error message: Cannot display this photo. —OR— Cannot display all photos. —
OR— Photos are corrupted.

Solution The memory card contains image formats the printer does not support,
or the files are corrupted. For a list of supported image formats, see Printer
specifications. Access photos using the computer. For information about accessing
photos through the computer, see Printing from a computer.

Error message: Unsupported card type.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer.
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Error message: Some photo numbers are not on card.
Solution Use your camera to transfer the photos to your computer, and then print
from your computer. If some photos are still missing, they may have been deleted
from the memory card.

Computer and connectivity printing errors
Before contacting HP Support, read this section for troubleshooting tips or go to the
online support services at www.hp.com/support.

Error message: Printer memory is full. Job was cancelled. Press OK.
Solution The printer encountered a problem when printing photos. Try the
following:
● To clear the printer memory, turn the printer off, then turn it on again.
● Print fewer photos at a time.
● Save the photos to the computer and print from there.
● Save the files to the computer using a memory card reader and then print from

the computer.

Error message: Communication error. Check computer connection. Press OK. —
OR— Data was not received. Check computer connection. Press OK to continue.
—OR— No response from computer.

Solution The printer cannot communicate properly with the computer. The printer
software may not be working or a cable may be loose. Make sure the USB cable is
securely attached to both the computer and to the USB port on the back of the printer.
If the cable is secure, verify that the printer software is installed.

Error message: Camera disconnected during print job.
Solution The print job will be cancelled. Reattach the USB cable to the camera
and printer and resend the print job.
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8 HP support

Support process

If you have a problem, follow these steps:
1. Check the documentation that came with the HP Photosmart.
2. Visit the HP online support Web site at www.hp.com/support. HP online support is

available to all HP customers. It is the fastest source for up-to-date device
information and expert assistance and includes the following features:
– Fast access to qualified online support specialists
– Software and driver updates for the HP Photosmart
– Valuable HP Photosmart and troubleshooting information for common problems
– Proactive device updates, support alerts, and HP newsgrams that are available

when you register the HP Photosmart
3. For Europe only: Contact your local point of purchase. If the HP Photosmart has a

hardware failure, you will be asked to bring it back to your local point of purchase.
(Service is provided at no charge during the device limited warranty period. After the
warranty period, you will be quoted a service charge.)

4. Call HP support. Support options and availability vary by device, country/region, and
language.

HP support by phone
For a list of support phone numbers, see the phone number list on the inside of the front
cover.

Phone support period
One year of phone support is available in North America, Asia Pacific, and Latin America
(including Mexico). To determine the duration of phone support in Europe, the Middle
East, and Africa, go to www.hp.com/support. Standard phone company charges apply.

Placing a call
Call HP support while you are in front of the computer and the HP Photosmart. Be
prepared to provide the following information:
● Device model number (located on the label on the front of the device)
● Device serial number (located on the back or bottom of the device)
● Messages that appear when the situation occurs
● Answers to these questions:

– Has this situation happened before?
– Can you re-create it?
– Did you add any new hardware or software to your computer at about the time

that this situation began?
– Did anything else occur prior to this situation (such as a thunderstorm, device

was moved, etc.)?
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After the phone support period
After the phone support period, help is available from HP at an additional cost. Help may
also be available at the HP online support Web site: www.hp.com/support. Contact your
HP dealer or call the support phone number for your country/region to learn more about
support options.
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A Specifications
This section lists the minimum system requirements for installation of the HP Photosmart software,
and provides selected printer specifications.
For a complete list of printer specifications and system requirements, see the onscreen
HP Photosmart Printer Help. For information about viewing the onscreen HP Photosmart help, see
Welcome.

System requirements

Component Windows PC minimum Macintosh minimum

Operating system Microsoft® Windows 98, 2000
Professional, Me, XP Home,
and XP Professional

Mac® OS X 10.3, 10.4, and
later

Processor Intel® Pentium® II (or
equivalent) and higher

G3, G4, G5 or Intel Core Duo
or greater

RAM 64 MB (128 MB
recommended)

Mac OS X 10.3, 10.4, and
later: 128 MB

Free disk space 500 MB 150 MB

Video display 800 x 600, 16-bit or higher 800 x 600, 16-bit or higher

CD-ROM drive 4x 4x

Connectivity USB: Microsoft Windows 98,
2000 Professional, Me, XP
Home, and XP Professional
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

USB: Front and back ports
(Mac OS X 10.3, 10.4, and
later)
PictBridge: using front
camera port
Bluetooth: using optional
HP Bluetooth Wireless
Adapter

Browser Microsoft Internet Explorer 5.5
or later

—

Printer specifications

Category Specifications

Connectivity USB: Microsoft Windows 98, 2000 Professional, Me, XP
Home, and XP Professional; Mac OS X 10.3, 10.4, and later

Image file formats JPEG Baseline
TIFF 24-bit RGB uncompressed interleaved
TIFF 24-bit YCbCr uncompressed interleaved
TIFF 24-bit RGB packbits interleaved
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Category Specifications
TIFF 8-bit gray uncompressed/packbits
TIFF 8-bit palette color uncompressed/packbits
TIFF 1-bit uncompressed/packbits/1D Huffman

Video file formats Motion-JPEG AVI
Motion-JPEG QuickTime
MPEG-1

Media specifications Recommended maximum length: 61 cm (24 inch)
Recommended maximum paper thickness: 292 µm (11.5
mil)
Recommended maximum envelope thickness: 673 µm
(26.5 mil)

Media sizes supported Supported sizes when printing from a computer
7.6 x 12.7 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Supported sizes when printing from the control panel
Metric: A6, A4, 10 x 15 cm (with and without tab); Imperial:
3.5 x 5 inch, 4 x 6 inch (with and without tab), 4 x 12 inch,
5 x 7 inch, 8 x 10 inch, 8.5 x 11 inch; Other: Hagaki and L-
size

Media types supported Paper (plain, inkjet, photo, and panoramic photo)
Envelopes
Transparencies
Labels
Cards: index, greeting, Hagaki, A6, L-size
Iron-on transfers
Avery C6611 and C6612 photo sticker paper: 10 x 15 cm
(4 x 6 inch), 16 rectangular or oval stickers per page

Memory cards CompactFlash Type I and II
Microdrive
MultiMediaCard
Secure Digital
Memory Sticks
xD-Picture Card

Memory card-supported file
formats

Printing: See Image file formats earlier in this table.
Saving: All file formats

Paper tray – media sizes
supported

Main tray
8 x 13 cm to 22 x 61 cm (3 x 5 inch to 8.5 x 24 inch)
Photo tray
Up to 10 x 15 cm (4 x 6 inch), with or without tab
Output tray
All supported Main tray and Photo tray sizes

Appendix A
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Category Specifications

Paper tray capacity Main tray
100 sheets of plain paper
14 envelopes
20–40 cards (depending on thickness)
30 sheets of labels
25 transparencies, iron-on transfers, or photo paper
10 sheets of photo paper
Photo tray
Output tray
20 sheets of photo paper
50 sheets of plain paper
10 cards or envelopes
25 sheets of labels or iron-on transfers

Operating environment Recommended temperature range: 15–30 °C (59-86 °F)
Maximum temperature range: 5–40 °C (41-104 °F)
Storage temperature range: -40–60 °C (-40-140 °F)
Recommended humidity range: 20–80% RH
Maximum humidity range: 10–80% RH

Physical specifications Height: 17.9 cm (6.8 inch).
Width: 46.25 cm (18.2 inch)
Depth: 38.7 cm (15.25 inch)
Weight: 7.7 kg (17.0 lb).

Power consumption Printing, Average: 75 W
Printing, Maximum: 94 W
Idle: 13.3–16.6 W

Power supply model number HP Part # 0957-2105

Power requirement 100–240 VAC (± 10%), 50–60 Hz (± 3 Hz)

Ink cartridges HP Yellow Ink Cartridge
HP Cyan Ink Cartridge
HP Light Cyan Ink Cartridge
HP Magenta Ink Cartridge
HP Light Magenta Ink Cartridge
HP Black Ink Cartridge

Note The cartridge numbers you can use with this
printer appear on the back cover of this printed
guide. If you have already used the printer several
times, you can also find the cartridge numbers in
the printer software. For more information, see
Insert ink cartridges.

(continued)
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Category Specifications

Print speed (maximum) Black printouts: 32 pages per minute
Color printouts: 31 pages per minute
Photos: 14 seconds for each 10 x 15 cm (4 x 6 inch) photo

USB support Microsoft Windows 98, 2000 Professional, Me, XP Home,
and XP Professional
Mac OS X 10.3, 10.4, and later
HP recommends using a USB 2.0 full-speed compliant
cable 3 meters (10 feet) or less in length.

Appendix A
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B HP Warranty
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Index

A
accessories 9
accessories, two-sided

printing 9
after the support period 58
aligning the printer 37
alignment page 37
alignment, required 52
antique coloration 27

B
Bluetooth

connecting to printer 21,
29

menu settings 9
wireless printer adapter 9

borderless prints 27
buttons 8

C
calling HP support 57
cameras

connecting to printer 21,
29

direct-printing 23
PictBridge 23
port 6
printing from 23

care and maintenance 37
cartridges. See ink cartridges
cleaning

copper-colored contacts
38

print head 38
printer 37

color effects 27
CompactFlash 18
computer

connecting to printer 29
printing from 33
saving photos to 31
system requirements 59

control panel 8

D
damaged, ink cartridge 51
date and time stamps 27

digital cameras. See cameras
Digital Print Order Format 22
documentation, printer 5
DPOF 22

E
e-mailing photos 31
energy consumption 4
Energy Star 4
error messages 48

F
file formats, supported 18, 59
Frequently asked questions

43

G
Getting help 43

H
Help 43
Hewlett-Packard Company

notices 4
home, screen 9
HP direct-printing digital

cameras 23
HP Instant Share 29
HP Photosmart Essential 33
HP Photosmart Premier 33
HP Photosmart Share 31, 34
HP Photosmart Studio (Mac

only) 34
HP Software Update 40

I
ink

checking level 39
empty 50
replace soon 50

ink cartridges
damaged 51
empty 50
expired 51
HP ink depleted 52
incorrect 50
ink level, checking 17
inserting 17

missing 51
non-HP ink 51
printer alignment 52
replace soon 50
replacing 17
storing 41
testing 39

ink level, checking 17
inserting

ink cartridges 17
memory cards 19

iPod 30

J
JPEG file formats 18

L
layout and photo size 24
lights 8
Load paper 13

M
Macintosh

HP Photosmart Mac
software 34

memory cards
inserting 19
printing from 21
removing 20
saving photos to a

computer 31
supported types 18

Memory Sticks 18
Microdrive 18
missing ink cartridge 51
MPEG-1 file format 18
MultiMediaCard 18

P
Paper

load 13
paper

buying and choosing 13
maintaining 13, 41
specifications 59
trays 6
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phone support 57
phone support period

period for support 57
photos

antique coloration 27
cropping 27
date and time stamp 27
e-mailing 31
framing 27
improving quality 26
printing 21
saving to computer 29
sepia tones 27
supported file formats 18
zooming 27

Photosmart Share. See
HP Photosmart Share

PictBridge cameras 23
placing a call 57
print head

cleaning 38
failure 53
stalled 52

print quality
changing 21

Printer
Specifications 59

printer
accessories 9
care and maintenance 37
cleaning 37
connecting 21, 29
documentation 5
error messages 48
home 9
parts 6
specifications 59
storing 41

printer software
updating 40

printer software, updating 33
printing

from a computer 33
from BlueTooth device 21
from cameras 23
from memory cards 21
from PictBridge camera 21
photos 21
range of photos 21
test page 39
without computer 21

Q
quality

photo paper 41
photos 26
printing test page 39

Questions and Answers 43

R
range

printing 21
regulatory notices

regulatory model
identification number 4

removing memory cards 20
replacing ink cartridges 17

S
saving photos to computer 29
Secure Digital 18
sepia tones 27
Sony Memory Sticks. See

Memory Sticks
Specifications 59
storing

ink cartridges 41
photo paper 41
printer 41

support 57
support process 57
system requirements 59

T
test page 39
TIFF file format 18
transporting printer 9
trays, paper 6
Troubleshooting 43
troubleshooting

error messages 48
two-sided printing 9

U
USB

connection type 29
port 6
specifications 59

V
video clip

supported file formats 18

X
xD-Picture Card 18

66 HP Photosmart D7100 series



www.hp.com   

© 2006 Hewlett-Packard Development Company, L.P.

Black

Yellow

Light Cyan

Cyan

Print Cartridge Selection Numbers

02

02

02

02

Light Magenta

Magenta 02

02

*Q7046-90227*
*Q7046-90227*
Q7046-90227

Printed in [country] - English


	Contents
	Welcome
	Special features
	Accessing the onscreen HP Photosmart help
	Printer parts
	Optional accessories
	Printer menu
	View & Print
	Save
	Share
	Settings


	Get ready to print
	Load paper
	Choose the right paper
	Paper loading tips
	Load the main tray
	Load the photo tray

	Insert ink cartridges
	Purchasing replacement ink cartridges
	Ink cartridge tips
	Ink cartridge warranty information
	Inserting or replacing the ink cartridges

	Insert memory cards
	Supported file formats
	Inserting a memory card
	Memory card types
	Removing a memory card


	Printing photos without a computer
	Printing photos
	Print photos from a memory card
	Print one or more photos
	Print all photos on the memory card
	Print camera-selected photos from a memory card
	Print using the Wizard
	Print photos from video clips
	Print a photo index
	Stop printing

	Print photos from a digital camera
	Digital camera with Bluetooth wireless technology
	Digital camera with PictBridge technology

	Print photos from an iPod

	Photo layouts
	Improving photo quality
	Adjust photos with poor brightness
	Remove red eye from photos
	Adjust poor-quality video clips

	Getting creative
	Add a color effect
	Add the date and time to your prints
	Change the print quality
	Crop a photo
	Print panoramic photos


	Getting connected
	Connecting to other devices
	Saving photos to a computer
	Connecting through HP Photosmart Share

	Printing from a computer
	Using creative options in the printer software
	HP Photosmart Premier (Windows users)
	HP Photosmart Essential (Windows users)
	HP Photosmart Studio (Macintosh Users)
	HP Photosmart Share

	Set print preferences
	Open the electronic help

	HP Real Life technologies features

	Care and maintenance
	Clean and maintain the printer
	Clean the outside of the printer
	Aligning the printer
	Print a sample page
	Automatically clean the printhead
	Manually clean the ink cartridge contacts
	Print a self test report

	Update the software
	Store and transport the printer and ink cartridges
	Store and transport the printer
	Store and transport the ink cartridges

	Maintain the quality of photo paper

	Troubleshooting
	Printer hardware problems
	Printing problems
	Error messages
	Paper errors
	Ink cartridge errors
	Memory card errors
	Computer and connectivity printing errors


	HP support
	Support process
	HP support by phone
	Phone support period
	Placing a call
	After the phone support period


	Specifications
	System requirements
	Printer specifications

	HP Warranty
	Index



